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Introduction 
 
The Transportation Asset Management System (TAMS) computer program was 

developed at Utah State University by the Utah Local Technical Assistance 
Program (LTAP) Center under the direction of Doyt Bolling.  The goal of the 
TAMS computer program is to serve as a tool for cities and counties to effectively 
manage their Transportation systems.  The program enables managers to perform 
both individual project level analysis and network level analyses to determine the 
best use of resources.  The program uses a Geographic Information Systems (GIS) 
interface that allows the user to “point and click” on a map to select individual 
transportation asset features such as street segments, signs, bridges, etc. for 
inventory, condition rating, analysis, and treatment tracking purposes.  The 
program also has a work order module to assist managers in tracking, recording, 
and completing work order requests. 

  
The TAMS computer program contains asset management modules for the following 

Transportation items: 
 

• Pavement Management 
• Signs and Sign Supports 
• Pavement Markings 
• Accident Analysis 
• Culverts 
• Cattle Guards 
• Bridges 
• Work Orders 

 
TAMS allows field and office entry and data storage covering inventory, condition 

assessments, analysis, and cost tracking.  It also provides the user with several 
useful reports. 

 
This manual is a “step-by-step” guide covering various features and functions of the 

program. 
 
Initializing the program 
Installation – To install the program: 
 

• Insert the TAMS CD – ROM installation disk 
• Through Windows Explorer, navigate to the TAMS installation disk  
• Double click on the file SetUp.exe   

 
This runs a setup program that first prompts the user for necessary information and then 
installs the program on the computer.  It is recommended that the program be saved to the 
following directory:  C:\Program files\TAMS.  The setup should store it to this directory 
by default 
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Data Needed to Begin 
Digital Maps – TAMS is most effective when an accurate GIS Map of the different 

transportation systems is used.  Normally, the Utah LTAP Center uses GPS to 
map the transportation features and create an ESRI shapefile.  When this is not 
possible, the LTAP Center assists in making a variety of formats, including ESRI 
coverages and AutoCad drawings, compatible with TAMS. 
 

Databases – A standard database (usually Microsoft Access) is used in the program.  A 
separate database is needed for each module.  These databases can be created with 
the necessary tables using the program.  The steps for creating the database for 
each module are explained in the individual module sections in this manual.  
TAMS is able to recognize database for each module.  Any changes made to these 
databases may cause problems.  Please call the Utah LTAP Center before making 
changes. 

 
 
Beginning Screen Components 
To initialize the program click on the TAMS icon created during installation.  An icon 

will be created on the desktop as well as in the start menu.  Figure 1 below shows 
the starting screen of TAMS that will appear when the program is initialized.   

 
 

 
 

Figure 1.  Starting Screen 
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The program module buttons do not appear on the starting screen shown in Figure 1.  

These buttons are used to select which module is “active” in the program (signs 
for example) and will appear once a database has been opened.  To activate a 
module the user must click on one of these buttons.  Only one module may be 
active at a time, but the user can easily switch back and forth between modules 
using these buttons.  Depending on which module is active a different set of pull 
down menus will appear.  This is because the program performs different 
operations for each module.  The following sections explain how to use each 
module. 
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Pavement Management Module 
 

Data Needed to Begin 
Importing Road Map – TAMS is most effective when an accurate GIS Map of the road 

system is used.  Normally, the LTAP Center uses GPS to map the street network 
and create an ESRI shapefile.  When this is not possible, the LTAP Center assists 
in making a variety of formats, including ESRI coverages and AutoCad drawings, 
compatible with TAMS. 
 

Database – A standard database (usually Microsoft Access) is used in the program.  Any 
changes made to this database may cause problems.  Please call the Utah LTAP 
Center before making changes. 

 
 
Opening the Database 
In order to begin using the pavement management module, a database containing street 

network data must be specified.  If no database exists (you are starting from 
scratch) you can use the program to create one with all of the necessary tables.  
First click on the Roads module button, then click on the File Menu, then New, 
then Database Then Pavements.   A Save As dialog box will appear asking the 
user to name the database and specify its location.  Once this is done click save 
and the user will be returned to the starting screen where maps can be added and 
the data collection process can begin.  When a new database is created in TAMS, 
a table is created in the database that “tells” the program it is for the pavement 
management module.   

 
If a database already exists, click on the File Menu, then Open, then Database.  An Open 

File dialog box will appear asking the user to specify the database.  When the 
database is selected and the “Open” button clicked, the user will be returned to the 
starting screen to load maps and view information. 

 
If a database is being opened for the first time the screen will appear as is shown in 

Figure 2. 
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Figure 2.  Beginning screen after new database is opened. 

 
 
The Map Feature 
 
As previously stated, TAMS uses a map interface to inventory and survey the condition 

of the road system.  This requires a GIS-based road map to begin the inventory 
process as outlined in the section “Data Needed to Begin.”  To load the GIS map, 
first select the Roads module button, then go to File, Open, Layer and choose 
the shapefile from the open file form.  This opens the selected shapefile in the 
program and saves the path to the directory in the database so that the next time 
the database is opened the shapefile will open automatically.  If the roads module 
button is not selected before opening the layer it will be associated with the wrong 
module and warning message box will appear indicating that required fields are 
not found in the shapefile.  With a base map in place, the map feature becomes the 
data-collection and editing tool for the information stored in the database.  Figure 
3 shows the map feature and outlines the basic components.   
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Figure 3.  Map Feature and Component Information 
 
If a layer needs to be removed, go to File, New, Map.  The map will be cleared and the 

correct layers can be added. 
 

Zoom-in button –
zoom in on map 

Pan button – 
pan through 
map 

Zoom – 
see full extent 
of map 

Identify button – 
must be active in 
order to select 
features on map 

Label button – 
displays form 
that allows 
customizing 
labels

Alternate 
method for 
selecting –
type in 
segment id of 
feature 

Color button –
specify color of 
active layer 

Map 
refresh 

New Layer 
button – add 
additional 
layers to map 

Module Buttons 
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Summary of Main Menu Components (Pavement) 
 
 
File Menu 

 New 
- Database – Creates a new database for the module selected with all of the 

necessary tables needed to collect data using TAMS  
- Map – Clears the current map  
- Layer – Adds a layer to the existing map 
-  

 Open  
- Database – Specifies a database to use 

 Exit Program – Shuts down the program 
 
 
Inventory/Condition Survey Menu 

- Edit Inventory – Allows editing independent of the map; uses a search mechanism 
to find the road name 

- Set Inventory Defaults –Sets default values to speed up the inventory and 
condition survey processes 

- View Rating Sheets – Allows viewing of the rating sheets for Asphalt, Concrete, 
and Unpaved roads used during the condition survey 

 
 
Analysis/Reports Menu 

  
 Define The Recordset – allows the user to analyze and create reports on defined 

subsets of the total system. 
 Analysis – allows the user to analyze treatment strategies and view the governing 

distress distributions of the road network. 
o Run Analysis – Runs the budget optimization portion of the program 

- Asphalt – Runs the budget optimization portion of the program for 
asphalt pavement 

- Concrete – Runs the budget optimization portion of the program for 
concrete pavement 

- Unpaved – Runs the budget optimization portion of the program for 
unpaved roads 

o Governing Distresses – Gives the following information of governing 
distresses affecting the asphalt, concrete, and unpaved pavement systems:  

  
• number of segments affected by each distress 
• percent of total area affected by each distress 
• percent of total area affected by smoothness  
• drainage problems   
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 Reports –  (the following reports are available for Asphalt, Concrete, and 
Unpaved roads)  
- Condition Report – Produces a report for each segment of the road, gives 

the remaining service life (RSL) and information for each distress 
identified 

- Inventory Report – Produces a report of Road Name, From Address, To 
Address, RSL, Area, and Percent Area 

- Recommended Treatment Report – Produces a report with the 
recommended treatment for each segment 

- Yearly Treatment report – Produces a report of treatments done in any 
given year 

- Report Designer – Allows the user to custom design a report with the 
desired title and field data.  In this report the data for all pavement 
types is included.  For all other reports either asphalt, concrete, or 
unpaved must be selected and only the records for that pavement 
type will be listed.  

 
 
Table Menu 

 Edit Distress Tables – Provides a screen to change distress criteria requirements 
for Asphalt, Unpaved, and Concrete roads. 

 
 
About LTAP Menu 
 LTAP Center – Provides information about the Utah LTAP Center 
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Initial Road Inventory 
There are two ways to enter data for a new segment: 
 
1. Use the map to identify features on which to add information: select the identify 

button on the toolbar and select the segment on the map  
2. Type in the segment id number in the box at the top of the map and press Enter  
  
When the segment selected is a new inventory, the Information box shown in Figure 4 
appears. 
 
 

 
 

Figure 4.  Add New Record Information Box 
 
The Information box indicates the segment selected has no information stored in the 

database.  The Add Inventory form appears, as shown in Figure 5.  The left side of 
the form is to add categorical information pertaining to the road’s location.  The 
right side of the form contains the distress-rating entry.  The distresses in the road 
are rated according to the SHRP Distress Manual.  The Utah LTAP Center has 
developed a field-rating sheet based on the SHRP Distress Manual.  This field-
rating sheet is shown in Appendix A as well as in the Inventory/Condition Survey 
pull-down Menu under “view rating sheets”. 
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Figure 5.  Add Information about Road Segment Form 
 
 
Once the information has been entered in form, press the “Save Record” button.  The 
RSL is calculated and a recommended treatment is determined and stored in the database.   
 
The figures below show the possible errors that may be given while trying to save the 
new segment information.  If all of the Location (left-side) information is not entered, the 
dialog box in Figure 6 appears.  If all of the Distress (right-side) information is not 
entered, the dialog box in Figure 7 appears.  If the data for the distress information is out 
of the correct range, the dialog box in Figure 8 appears. 
 
 

 
 

Figure 6.  Location Information Missing Dialog Box 
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Figure 7.  Distress Information Missing Dialog Box 

 

 
 

Figure 8.  Distress Information Out-of-Range Dialog Box 
 
If the information is formatted correctly, the dialog box in Figure 9 appears, indicating 
the database was updated with the new information.  Repeat the process for another new 
segment.  To edit the information, click on the segment again.  For information on 
editing, proceed to the next section. 
 

 
 

Figure 9.  Database Updated Dialog Box 
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Editing Information 
To add or edit information, click the “identify” button on the mapping toolbar shown in 

Figure 3.  This allows the user to select features on the map.  When the segment 
selected has not been inventoried, the Information box shown in Figure 4 appears.  
If the segment has information already stored for it, the Edit Inventory form 
appears, as shown in Figure 10. 

 

 
 

Figure 10.  Edit Inventory Form  
 
This form allows the user to change location information or add new distress information 

about the road segment.  To modify information on the left side of the form, make 
the desired changes and click the “Update Location Information” button.  The 
confirmation dialog box shown in Figure 11 appears. 

 
 

 
 

Figure 11.  Update Location Confirmation Dialog Box 
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Distress Information 
To update distress information, a further step is required.  First, click on the “Add New 

Distress Information” button.  A message box appears asking, “Are you sure you 
want to add new distress information?”  The reason for this extra precaution is 
another record will be added to the database when this information is saved.  To 
proceed, click the “Yes” button; a new button appears on the Edit Inventory form.  
Change the distress information as needed, then press the “Save New Distress 
Information” button. The information is added to the history table for that 
segment. 

 
Editing Segments Alternative Method 
In addition to utilizing the map to edit previously inventoried segments, the following 

method is available:   
 

1. From the starting screen go to the Inventory\Condition Survey Menu and 
click “Edit Inventory.”  The form (shown in Figure 12) appears.   

2. The “Find” button results in another window, allowing the road name to be 
entered.  The road name needs to match exactly in order for the records to 
appear.   

3. Once the road name is entered, press the “Go Find” button and the program 
returns to Figure 13 showing only those segments for the road name entered.    

 
Use the navigation tool in the Edit Inventory Alternative form to scroll through the 

records until the desired record is found.  Then press the “Go To Segment” 
button, and the Edit Inventory Information form (shown in Figure 12) appears, 
allowing segments to be edited or segment information to be viewed. 

 

 
 

Figure 12.  Edit Inventory Alternative Form 
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Adding Segments (without map information) 
Adding Segments (without using the map) can be done in the map feature.  By entering a 

unique segment ID and pressing Enter, the program will proceed to the Add 
Inventory form.   

 
Note: Record these additional segment ID’s.  They will not be tied to the map until the 

segments are mapped and added to the base map.  It will be necessary to use the 
same segment ID number when mapping the segments as was used to inventory 
the segment in the program.  Otherwise the inventoried data will not be linked to 
the correct feature on the map. 
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Documenting Comments, Viewing Pictures, Entering 
Treatments, and Viewing History 

Once the Edit Inventory Information form is open (as shown in Figure 13.  Edit 
Inventory Information Form 

), the buttons at the bottom allow for tracking of treatments, entering comments, and 
viewing a picture and distress history.  The forms and viewing tools are shown in 
the figure. 
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Figure 13.  Edit Inventory Information Form 

Pavement Performance 
The pavement performance curve for the segment is another feature available from the 

Edit Inventory form.  This feature allows the user to view the performance of the 
pavement with respect to RSL vs. time.  Figure 14 shows an example of this 
feature. 
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Figure 14.  Pavement Performance Curve 
 
Storing Pictures 
Pictures are stored in the TAMS directory as the application in a folder named “Picts.”  
In order for the program to recognize the link, the pictures must be JPEG type files.  

Pictures can be stored in the database by using the picture form accessed through 
the Edit Inventory form. 
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Reporting Functions 
Inventory Report 
The Inventory Report gives the detailed location information, classification, percent area, 

and RSL for each of the road segments. To access the Inventory Report, select the 
report menu (from the main screen), select the desired surface type (asphalt, 
concrete or unpaved), and click the “Inventory Report” button.  This information 
is critical in determining an engineer’s estimate for a future project. Figure 15 
shows an example of the Inventory Report.  

 

 
 

Figure 15.  Inventory Report 
 
 



  19 

Condition Report 
The Condition Report reports the severity, extent, and RSL for each segment of road in 

the management system. To access the Condition Report, select the report menu 
(from the main screen), select the desired surface type (asphalt, concrete, or 
unpaved) and click the “Condition Report” button.  This information is critical in 
determining the appropriate treatment for a given road system. Figure 16 shows 
an example of the Condition Report.  

 
 

 
 

Figure 16.  Condition Report 
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Recommended Treatment Report 
The Recommended Treatment Report can be utilized to determine what projects could 
become a priority.  A manager could look at all the roads recommended for crack sealing 
and determine which should be done for this particular year.  This limits the number of 
sections a pavement manager must read to make good engineering judgments about the 
road system. To access the Recommended Treatment Report, select the report menu (from 
the main screen), select the desired surface type (asphalt, concrete, or unpaved) and click 
the “Recommended Treatment Report” button.  This information is critical in 
determining the appropriate treatment for a given road system. Figure 17 shows an 
example of the Recommended Treatment Report.  
 
 

 
 

Figure 17.  Recommended Treatment Report  
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Budgeting and Network Analysis 
 

Need for Network and Budgeting Analysis 
An effective pavement management program allows the user to accomplish 3 things: 
 
Provide an accurate inventory 
Manage segments separately 
Maximize service level with a yearly budget 
 
Until now, we have focused on the first two elements.  This section focuses on the final 

element of providing a budgeting tool that will maximize service level with a 
yearly budget. 

 
To run the analysis tool from the starting screen, select the analysis menu and click “Run 

Analysis.”  The analysis tool appears, as shown in Figure 18.  Looking at the 
output portion of the tool, notice that in the year 2000 the distribution is as shown 
in Table 1.  This is the current RSL distribution for the street network.  The goal 
of the analysis it to obtain the highest average network RSL within budget 
constraints.   

 
The other information shows the percentage that falls within the cited RSL categories.  

For example, 26.37% of the road system is in the RSL category of 4-6 years.  
Roads in this category typically require some form of rehabilitation.  This is also 
true for the segments in the 7-9 RSL category.  Roads falling in the 0 and the 1-3 
RSL categories will require reconstruction, while roads in the 10-12 category are 
good candidates for preventative maintenance.  Routine maintenance treatments 
can be applied throughout the pavement’s life cycle. 

 
Understanding what information this table exhibits is critical in conducting a network 

condition and budget analysis of the system.  The next section deals with 
information on how treatments are simulated in this analysis program. 

 
Table 1.  Year 2000 Distribution 

Year 0 1-3 4-6 7-9 10-12 13-15 16-18 19-21 Avg. RSL 
2000 .88 4.06 26.37 14.01 18.08 8.66 22.05 5.89 10.69 
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Figure 18.  Analysis Setup Form 
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Applying a Treatment Strategy to the Budget Analysis 
On the average, each road will lose serviceability at the rate of 1 RSL per year.  

Treatments can be applied to a certain RSL category to deter the deterioration of 
roads that come into it.  For instance, one could apply chip seals to the 10-12 RSL 
category by clicking the “Single Chip Seal” button in the analysis form. Figure 19 
shows the form that appears: 

 

 
 

Figure 19.  Allocation of Single Chip Seal Applications 
 
This form allows the user to select the RSL categories in which to apply chip seal 

applications.  Chip seals are most effective if done in the 10-12 RSL category.  
The program will automatically add 5 years to the roads treated with a chip seal in 
the 10-12 RSL category.  The program also recognizes that if chip seals are 
applied in the less optimal 4-6 RSL category, the added life will only be 2-3 
years.   
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To apply chip seal applications first allocate what percentage of chip seals will be applied 
to each category.  A good starting point is allocating 100% in the 10-12 RSL 
category as shown in Figure 20.  Allocating 100% in the 10-12 year RSL category 
means 100% of the chip seals performed will be on roads with an RSL of 10-12 
years. 

 
 

 
 

Figure 20.  Allocation of Single Chip Seal (Allocation 100% in 10-12 RSL) 
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The next step is to allocate a percentage of the system to treat with chip seals.  After 
clicking the “Apply” button, the program will return to the Analysis Setup form.  In this 
form, change the number in the chip seal category from 0 to 10 as shown in Figure 21.   
 
 

 
 
 

Figure 21.  Analysis Setup Form 
 

Changed from 0 to 10 
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As can be seen, the number of roads in the 10-12 year RSL category has decreased 
substantially.  The road system is beginning to improve, but further treatments 
will be required.  It is suggested to continue with analysis, allocating 4 percent to 
thin hot mix overlays, broken into 50% in the 4-6 and 50% in the 7-9 RSL 
categories.  Then, allocating 1.7% to base replacement and pavement replacement 
with 100% in the 0 RSL category, as well as, allocating 1.5 percent to Thick 
Overlays (>2”) broken into 50% in the 0 and 50% in the 1-3 RSL categories. 
Figure 22 shows the results of this analysis. 

 
 

 
 

Figure 22.  Analysis of Road System 
 
As can be seen from Figure 22, the Average RSL has begun to increase.  The objectives 
to use in determining an effective preservation strategy are: 
 

1. Average RSL >12 years 
2. Less than 3% of the system falls into the 0 and 1 – 3 RSL categories 
3. Normal distribution with the mean falling at about 12 years RSL 
 

For this model, all the criteria were met except for the fact that more than 5% of the 
system is in the 0 RSL category.   
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Saving the Analysis 
To save the analysis information, select the file menu and click the “Save Allocation” 

menu. Figure 23 shows the form that opens. 
 
 

 
 

Figure 23.  Save Allocation Scheme Form 
 
Type a name that represents the analysis conducted, such as “2000 Road Budget.”  Then 

click the “Save” button.  The next time the analysis tool is opened, the “Open 
Allocation” menu in the File menu of the Analysis Setup form can be selected.  
By selecting a previously saved allocation scheme, the allocation will be applied 
to the system even if the system distribution has changed since the last analysis.  

 
Printing the Analysis Results 
The analysis shows how the network is changing over the analysis period.  The analysis 

is shown in the white section of the “Analysis SetUp” form. To print the analysis, 
select the “File” menu button and click the “Print Analysis” button in the 
“Analysis SetUp” form. Figure 24 shows the Analysis Report. 



  28 

 
 

Figure 24.  Analysis Report 
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Printing the Allocation Results 
The network allocation is critical in showing what affects the network analysis.  The 

allocation shows what treatments were used and when they were applied.  The 
allocation is behind the scenes in the “Analysis SetUp” form. To print the 
allocation, select the “File” menu button and click the “Print Allocation” button in 
the “Analysis SetUp” form. Figure 25 shows the Allocation Report. 

 
 

 
 

Figure 25.  Allocation Report 
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Viewing Graphical Yearly Distribution 
Another feature of the program is the Graphical Yearly Distribution Charts.  To utilize 

this feature in the “Analysis SetUp” form, select the “Tools” menu button and 
click the “View Yearly Distribution Chart” button.  The form Distribution of 
Remaining Service Life appears, as shown in Figure 26.  Enter in the first year of 
the analysis to view the distribution.  

 
 

 
 

Figure 26.  Distribution of RSL Form 
 
Figure 27 shows the distribution of the system in 2001.  This is the current RSL 

Distribution of the road network.  To observe the effects of the analysis click the 
“Previous Year” or “Next Year” button. The respective distribution for those 
years is shown. 
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Figure 27.  Distribution of RSL (2001) 
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Modifying Treatment Costs 
The program allows the pavement manager to account for changes in treatment costs.  To 

access this option from the Analysis Setup form, select the “Tools” menu button 
and click the “Edit Cost Tables” button. Figure 28 shows the Edit Costs of 
Treatment form below.  To make changes, enter the change in the respective cell 
and click the “Update Changes” button.  A confirmation verifying, “The changes 
you requested will be updated in the database,” appears. Click “OK” and the 
value will be updated.  Using inaccurate costs can have a drastic effect on the 
results of the analysis. 

 
 

 
 

Figure 28.  Edit Costs Form 
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Updating Distress Relationships 
This program is based on an accurate distress survey.  All of the information used for 

reporting and analysis is linked to a table including a distress rating, RSL, and a 
recommended treatment. To access these tables, select the Tables menu from the 
programs start page and click the “Edit Distress Tables” button. By clicking the 
appropriate button, the Distress Tables form that appears, shown in Figure 29, 
will access the distress table for each distress type. Figure 30 shows the distress 
table for fatigue cracking. The program calculates the RSL and a recommended 
treatment by analyzing each distress and determining a governing distress.   

 

 
 

Figure 29.  Distress Tables Form 
 

Figure 30.  Fatigue Cracking Distress Table 
 
 
This form allows the user to update the distress tables by changing the RSL or selecting a 

new Recommended Treatment for each distress rating and then clicking the 
“Update Changes” button.  A confirmation appears and the changes will be made 
to the database.  This same operation can be done for all 8 distress types shown in 
Figure 29. 

 
Note: This will not affect the roads that have already been inventoried, but it will affect 
those re-inventoried or added to the system later. 
 

Pull-Down Menu- 
Change Recommended 
Treatment 

Change the RSL for the 
given Distress 
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Define The Recordset 
TAMS also allows the user to analyze groups of roads smaller than the entire road 

system.  By selecting the Define the Recordset from the Analysis/Reports menu 
the user can specify the group of roads to analyze based on Functional 
Classification, Jurisdiction, District, etc. 
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Signs and Sign Support Module 
 
 

Data Needed to Begin 
Importing Sign Support Map – TAMS is most effective when an accurate GIS Map of 

the transportation system is used.  Normally, the LTAP Center uses GPS to map 
the sign network and create an ESRI shapefile.  When this is not possible, the 
LTAP Center assists in making a variety of formats, including ESRI coverages 
and AutoCad drawings, compatible with TAMS. 
 

Database – A standard database (usually Microsoft Access) is used in the program.  Any 
changes made to this database may cause problems.  Please call the Utah LTAP 
Center before making changes. 

 
 
Beginning Screen Components 
 
Figure 31 shows the starting screen of TAMS. 
 
 

 
 

Figure 31.  Starting Screen 
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Opening the Database 
In order to begin using the signs module, a database containing sign and sign support data 
must be specified: click on the File Menu, then Open, then Database.  An Open File 
dialog box will appear asking the user to specify the database.  When the database is 
selected and the “Open” button clicked, the user will be returned to the starting screen to 
load maps and view information.  If an existing database is not available (you are starting 
from scratch), click on File Menu, then New, then Database, then Signs.  A Save As 
dialog box will appear asking the user to specify where the database is to be saved.  
When the save button is clicked, a database with the required tables is created and opened 
for use. 
 
 
The Map Feature 
 
As previously stated, TAMS uses a map interface to inventory and survey the 

transportation system.  For signs, this requires a GIS-based map of the support 
locations to begin the inventory process as outlined in the section “Data Needed 
to Begin.”  In the Signs Module only the Sign Supports are mapped.  To load the 
GIS map for the Sign Supports, first select the Signs module button, then go to 
File, Open, Layer and choose the shapefile from the open file form.  This will 
open the selected shapefile in the program and save the path to the directory in the 
database so that the next time the database is opened the shapefile will open 
automatically.  With a base map in place, the map feature becomes the data-
collection and editing tool for the information stored in the database.  Figure 3 
from the Pavements section shows the map feature and outlines the basic 
components.   

 
 

Summary of Main Menu Components (Signs) 
 
 
File Menu 

 New 
- Database – Creates a new Signs database with all of the necessary tables 

needed to collect data using TAMS  
- Map – Clears the current map  
- Layer – Adds a layer to the existing map 

 Open  
- Database – Specifies a database to use 

 Exit Program – Shuts down the program 
 
 
Inventory/Condition Survey Menu 

- Edit Sign Inventory – Allows editing independent of the map; uses a search 
mechanism to find the road name 

- Set Inventory Defaults – Sets default values to speed up the inventory process.   
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Reports Menu  

- Support Report – Creates a report containing the condition of supports and their 
associated signs 

- Report Designer – Allows the user to custom design a report with the desired title 
and field data. 

 
About LTAP Menu 

- LTAP Center – Provides information about the Utah LTAP Center  
 
 

Initial Support/Sign Inventory 
There are three ways to enter data for a new Support and its associated signs: 
 

1. Use the map to identify features on which to add information: select the identify 
button on the toolbar and select the support on the map  

2. Type in the Support ID number in the box at the top of the map and press Enter 
3. Go to the Inventory/Condition Survey Menu and select Edit Sign Inventory 

 
If options 1 or 2 are selected, the resulting form will only display the support and 

associated signs selected.  If option 3 is selected, a listing of all supports and 
associated signs will be displayed. 

 
When a support is selected that has not been inventoried previously, the message box 

shown in Figure 32 will appear. 
 
 

 
 

Figure 32.  Add New Record Information Box 
 
The Information box indicates the support selected has no information stored in the 

database.  Click OK, and the Sign Input form appears, as shown in Figure 33.  The 
top section of the form is to add information pertaining to the sign support.  The 
bottom section of the form contains the information for the individual signs 
attached to that support.   
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Figure 33.  Sign Support and Sign Inventory Form 
 
 
For an explanation of the individual fields on the sign inventory form see Appendix B.  

To save information for a sign support and its signs, enter the required 
information in the support section and click save.  Once the information has been 
saved, press the “Add Sign” button to add information to for a sign and click on 
save when the information is entered.  To add additional signs click on the add 
sign button again and repeat the process described previously.     

 
The figure below shows a possible error that may be given while trying to save the sign 

or support information.  If all of the Support or Sign information is not entered, 
the dialog box in Figure 34 appears.   

 
 

 
 

Figure 34.  Information Missing Dialog Box 
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If the information is formatted correctly, the dialog box in Figure 35 appears, indicating 
the database was updated with the new information.  To edit the information, 
click on the support again.  For information on editing, proceed to the next 
section. 

 

 
 

Figure 35.  Database Updated Dialog Box 

 
 

Editing Information 
To edit information about a specific support and/or its signs, click the “identify” button 

on the mapping toolbar shown in Figure 3. This allows the user to select features 
on the map.  If the support has information already stored for it, the Sign Input 
form appears, as shown in Figure 36. 

 
 

 
Figure 36.  Sign Input Form 
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This form allows the user to change or add information for the  Support or Sign.  Note 
that in order to display the information for a sign it must first be selected in the 
sign window (R1-1 for Figure 36).  To modify information on the left side of the 
form, make the desired changes and click the “Save” button.  The confirmation 
dialog box shown in Figure 37 appears. 

 
 

 
 

Figure 37.  Confirmation Dialog Box 

 
 
 
Editing Supports and/or Signs Alternative Method 
In addition to utilizing the map to edit previously inventoried supports and/or signs, the 

following method is available:   
 

1. From the starting screen go to the Inventory\Condition Survey Menu and 
click “Edit Sign Inventory.”  The Sign Input form (shown in Figure 33) 
appears.   

2. In the Sign Input form a list of all of the previously inventoried supports (in 
ascending order) will be shown in the supports window.  The user can scroll 
through the supports and click on one to view its information    

3. Once the support number is selected, the signs associated with that support 
will be listed in the sign section.  To view the information for a particular sign 
the user must click on the sign and the information will appear.    

 

 
Adding Supports (without map information) 
Adding supports (without using the map) can be done in the map feature.  By entering a 

unique support ID and pressing Enter, the program will proceed to the Add 
Inventory form.   

 
Note: Record these additional support ID’s.  They will not be tied to the map until the 

supports are mapped and added to the base map.  It will be necessary to use the 
same support ID number when mapping the supports as was used to inventory the 
support in the program.  If this is not done the inventoried data will not be linked 
to the correct feature on the map. 
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Documenting Comments, Viewing Pictures, Entering 
Treatments, and Viewing History 
 
Once the Edit Inventory Information form is open (as shown in Figure 38), the buttons on 

the form allow for tracking of installation dates, entering comments, and viewing 
pictures.  The forms and viewing tools are shown in the figure. 

 
Figure 38.  Edit Inventory Information Form 

 
 
Storing Pictures 
Pictures must be stored in a directory on a PC or a server that can be accessed from the 

computer on which TAMS is installed.  In order to link the pictures to the correct 
features a table must be built in the database that links Location ID to the picture 
number.    

In order for the program to recognize the link, the pictures must be JPEG type files.  
Pictures can be stored in the database by using the picture form accessed through 
the Sign Input form.  This will create the table needed for TAMS to link the 
pictures to the correct features.  However, building the table this way can only be 
done one picture at a time, which is very time consuming if there are a number of 
pictures to be linked.  For help on linking large numbers of pictures contact the 
Utah LTAP Center.   

 
Reporting Functions 
 
Support Report 
The Support Report reports the following information: 

 Support ID 
 Road Name 
 Address 
 Support Type 
 Support Rating 
 Signs (MUTCD) on the Support 
 Condition of signs 

 
Report Designer 
The Report Designer allows customization of a report for at least four fields (such as 
MUTCD, ID number, condition, visibility, etc.).  Fields for both signs and supports can 
be selected.  
 
Figure 39 shows the sign input form along with many of the support functions previously 

discussed 
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Figure 39. Edit Sign Inventory Form and Support Functions 
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Appendix A  

Field Distress Rating Sheet for Asphalt Roads 
 

 




